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The Labeling Solution for Mineral Collectors And Dealers
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OsoSoft License Agreement
By using this program, you agree to the terms of this license agreement.

Multiple Use

You may create and use as many copies of this program as you wish. You may give copies of this
program to others. It is free. You can’t sell MineralLabel to anyone, under any circumstances,
however.

No Distribution of This Program

You may not sell copies of this registered version to other users under any circumstances. You may
not post this program on any website, but you may link to the OsoSoft Mineral Connection on your
website to share the program with others.

Commercial Distribution

OsoSoft is the sole distributor of this program. Under no circumstances may this program be sold,
distributed, or copied for sale without the express written permission of OsoSoft and George
Campobell.

Copyright Information

The computer program described in this manual, this manual, and the OsoSoft logotype are
Copyright, 1992-2000, by OsoSoft and George Campbell. All rights protected under copyright laws
worldwide are reserved by the copyright holder.

Support Policy

OsoSoft cannot offer detailed support for this program, since it is being distributed free of charge.
However, customers who have previously paid for this product are entitled to full support of
their copies, as indicated in their original manuals. Limited support for other users can be
obtained via email. To email about MineralLabel, go to www.osomin.com, then click any of the
email links there. Be as specific as possible about the problem, and I’ll try to help.




INTRODUCTION

System Requirements

MineralLabel requires a 386/486 CPU, Windows 3.1 or Windows 95/98, a hard disk and mouse,
plus a minimum of 2 MB of RAM and 2 MB of hard disk space, VGA or better graphics and a
Windows compatible graphics printer You’ll also need about 6 MB of free disk space on the disk
where you store .TMP files for Temporary files. This program supports only TrueType and Adobe
Type Manager fonts.:

Please read this manual thoroughly. It’ll save you a lot of time and help you use the program
better.

INSTALLATION

If you received a copy of MineralLabel 5.0 on a floppy disk, first start Windows. Then, insert the
MineralLabel program disk in drive A: or drive B:. From Program Manager, select the Run
command from the File menu and type A:SETUP or B:SETUP, then press <Enter>. (In Windows
95 or 98, choose Run from the Startup menu.) Follow the prompts on the screen, supplying a
different directory name for the program, if you wish.

If you are installing MineralLabel from a downloaded copy, place the MLDISK.EXE file you
downloaded on a floppy disk, or in a folder of its own. Start Windows Explorer, then locate
MLDISK.EXE on the floppy disk or in its folder. Double click the file to run it. That will extract all
the files in this self-running archive into the same directory that holds MLDISK.EXE. Next, in
Windows Explorer, double click the SETUP.EXE file extracted from MLDISK.EXE. SETUP.EXE
will either be on the floppy disk or in the folder on your hard disk where you stored the original
download.

NOTE: If you receive an error message during installation telling you that a DLL file cannot be run,
you will have to close all programs in your taskbar, then try the installation again. This does not
usually occur, but if it does, just right-click each program in your task bar, then click Close. A few
taskbar programs do not offer a Close command on a right click. For these, double-click the taskbar
icon, then exit the program.

Note for International Users

Due to a flaw in Windows 3.x, you must use U.S. style numerical notation when using
MineralLabel . Otherwise dimensions will be lost when files are saved, then reloaded. To change to
this notation, double-click the International icon in the Windows Control Panel, click the Number
Format button, then change your settings to use a comma (,) as a thousands separator and a period
(.) as a decimal separator.

Uninstalling MineralLabel

If you ever need to uninstall MineralLabel, simply delete all files from the directory in which you
installed the program, then remove the directory. You can do this using File Manager or Explorer in
Windows 95. During installation, MineralLabel also installed several DLL and VVBX files in your



Windows\System directory. Since these files may also be used by other programs, we recommend
that you do not delete these files.

Installing the POSTNET Bar Code Font

If you plan to use MineralLabel’s Automatic POSTNET Bar Code feature, you’ll need to install the
OsoPostTT TrueType bar code font in Windows. To do this, follow the steps below. You’ll find
OSOPOST.TTF, the font file, in your MineralLabel directory.

Windows 3.x
e Run the Fonts application in the Windows Control Panel.

e Click Add, then change to your MineralLabel directory.
e Locate the OsoPostTT font and select it by clicking on it.
e Click OK.

e Close the Fonts dialog and Control panel, then restart Windows.

Windows 95
e Open the Control Panel from My Computer, then run the Fonts application.

e Select File*Install New Font

e Change to your MineralLabel directory, then choose OsoPostTT from the list.
e Click OK, then close the font selection and My Computer windows.

e Restart Windows 95.

USING MineralLabel

To run MineralLabel, double click the MineralLabel icon in the Program Manager (In Windows95,
use the Start Menu). A notice will appear on your screen as the program loads and creates its font
list. If you have a large font library, this may take up to a minute. On subsequent program loading,
the program will load the font list from its own file.

Next, you’ll see the MineralLabel main screen. Unlike many other Windows programs,
MineralLabel uses command buttons and drop-down list boxes, rather than menus, to perform many
functions. Most commands you need to create label designs are right on the screen, grouped
according to function. Traditional Windows menus offer other commands. As with most Windows
programs, shortcut keys are available for most functions.

HELP TIP: Whenever you wonder what a button or command does in MineralLabel, just right
click on the button. A help line will appear in the MineralLabel title bar.



EDITING AND DISPLAY WINDOWS

You’ll see two windows on the screen. At the top is the text-editing window. Here, you’ll enter and
edit all the text to be included on your label. Just below it is another window, where a WYSIWYG

display of your label appears. You can’t edit text directly in this window, although many functions

operate by clicking in this window.

Editing Text in MineralLabel

MineralLabel’s text box works much like your Windows word processing program. You can simply
type your text in the box, pressing <Enter> to move to a new line. To position the cursor in your
text, use the cursor keys or click the mouse pointer where you want to type. If you select text by
dragging with the mouse, new text you type replaces the selected text. The WYSIWYG display
updates when you press <Enter> or perform any formatting command. When you’re entering text,
all attributes continue from line to line when you press the <Enter> key. When you delete lines,
remaining text maintains its formatting. You are limited to 80 lines of text in MineralLabel.

NOTE: It’s very important to remember that MineralLabel depends on text lines for formatting.
Before performing any formatting operation, select the line of text you want to format by
positioning the cursor on that line in the upper text window.

TUTORIAL: YOUR FIRST SHEET OF LABELS

This brief tutorial will help you understand the principles of using MineralLabel. The program can
do much, much more than produce simple labels, though. Read the rest of this manual to discover
MineralLabel’s other features and experiment with them until you’re comfortable using them on
actual labels.

e In the Layout menu, choose a Label Format option which matches the size you want. The
default is Avery 5160, which are 1” X 2 5/8” labels, the most popular size.

e Choose a font and font size for the first line of your labels, using the drop-down lists at the
right of your screen. The default is Arial 10 pt.

e Type in the text for the first line of your label. Don’t press <Enter> yet.

e Choose an alignment for your text in the drop down list at the right of your screen. Left
aligned is the default. TIP: If you want all the lines of your label to be aligned the same way,
click the Layout menu and choose one of the alignment options there.

e Press <Enter>, then type the next line for your label. As long as you don’t make any
formatting changes, each line will have the same formatting as the first line.

e Continue typing lines of text for your label until you’ve entered all your text. You don’t
have to press <Enter> after the last line to see that line on the screen. Click the [Update]
button instead.

e If you’d like your label to include a POSTNET bar code, select Automatic PostNet Bar
Codes in the Options menu. You may have to reduce the font sizes on your label to
accommodate the space used by the bar codes.



e Now that all your text is entered, you can make layout changes. Start by making the first line
a little larger than the others. To do this, click with the mouse on the first line in the Text
Box at the top of the screen. Then, drop down the Font Size list on the right and click on a
larger font size. The WYSIWYG screen will update instantly.

e Now, let’s add boldfacing to the first line. Since the cursor’s already on that line, just click
the Bold checkbox on the top right section of the screen.

e These changes may have caused the last line of your label to run off the window. Move the
cursor to the second line in the Text Box, and reduce the font size slightly. To make the
remaining lines the same, move the cursor down to each line, then click the [Dupe Prev]
button. NOTE: All formatting commands work on the line holding the text box cursor.

e If you’d like to add a graphic image to your label, click the [AddArt] button and select a
graphic file from the list, then click OK. You can use up to two images per label.

e If the image is too large, use the [Scale] Scroll Bar in the Clip Art section of the commands
on the right to decrease its size.

e To move an graphic, make sure that the Pic 1 or Pic 2 option button is marked, then left-
click in the WYSIWYG window outside of the graphic. Hold down the button to drag the
image around until it’s where you want.

e With an image on your label, you may want to switch text to be Right Aligned. Use the
Layout menu to apply this formatting to the entire label quickly.

e Toadd a line, box or circle to your label, click the appropriate item on the bottom right of
your screen. Choose a color, if desired, plus a line width if you want something other than a
thin line, then click the [Draw] check box. Now left-click in the WYSIWYG window where
you want the object’s upper left corner and drag the object to size. When you release the
mouse button, the object will appear.

e When your label looks just the way you want, click the File menu, then click Print Single
Test Label. Don’t put label paper in your printer yet, though. Print your test on plain paper.
Once the page emerges from the printer, hold it up behind a sheet of the labels you’ll use
and check the alignment. If it’s not perfect, use the Fudge Factors command in

e the Layout menu to shift printing, and test again. Once everything’s perfect, save your fudge
settings as defaults. You won’t have to set them again, in most cases.

e Finally, insert a sheet of label stock in your printer and select the Print Sheets of Labels
command in the File Menu to print out your return address labels.

COMMAND REFERENCE

LEFT SIDE COMMAND BUTTONS

The Text Group

[Edit]—This button returns the cursor to the text editing box.



[Click to Move Text]—This command lets you move text instantly to any position. To use this
check box, position your cursor in the upper text box on the line of text you want to move. Then
click this command. Now, click in the WYSIWY G display and drag the resulting box to the
location where you want the text to appear. NOTE: with some line formats, like rotated text, the
box will not reflect the actual angle or size of the text, but the upper left corner will be accurately
positioned. Also, you cannot click inside a graphic image to move text, although you can later drag
the text over the image. To position text inside a graphic image, select the [HideArt] button before
dragging text.

[TxtColor]—To choose a color, first place your text box cursor on the line you want to change.
Then click a color bar.

[Custom]—Click this button to use the Windows standard custom color dialog box, choose one of
the color selections or click Define Custom Colors to create a new color. Experiment with sample
printouts to get just the color you want.

The Label Group

[Update]—This button updates the WYSIWYG display. If the WYSIWYG display is not complete
after returning from a dialog box, click this button.

[Clear]—This button clears your current label from the screen and from memory.

[Grid]—This button overlays a grid on the WYSIWYG display to help you position text and
graphics. The grid has divisions of .1-inch, with full inch lines in bold. Click the button again to
remove the grid.

[Zoom]—This button can help you see large size label formats. While you can’t edit zoomed labels,
you can view them and scroll the WYSIWYG display to see the entire label. When you click this
button to zoom a label, the button’s caption changes to read [UnZoom].

[Scale]—This displays the current magnification of your WYSIWYG window. In most cases it will
read 100%, but for large-sized labels it may show another value. If the value is anything other than
100%, you can use the [Zoom] button to see an enlarged view.

RIGHT SIDE COMMANDS
Text Attributes (Whole Line)

[Line]—Displays the current line number, as determined by the position of your cursor in the text
editing box.

[Dupe Previous]—This button allows you to repeat the formatting of the line above the current line.
This is useful whenever you want duplicate formats on several lines. Just format any line, then
move to the next line and click this button. All line attributes will be duplicated.

[Font]—This drop-down list box displays the current font, and allows you to change a line to
another font. Click on the arrow to drop down the font selection list. Scroll through the list, then
click on your font selection.



[Size]—Displays the current font size for the current line. Click the arrow to drop down a list of
available font sizes. Sizes range from 4 to 72 points, in one-point intervals for the smaller fonts.
HINT: Changing the font size of a blank line affects line spacing.

[Align]—This control affects the alignment of the current line. To change, click the arrow, then
select your option. You can choose left or right aligned, centered, split lines, or set a customized
horizontal and vertical position. HINT: When using customized line positions, apply these to lines
at the bottom of the label’s text to avoid later misalignments in normal lines.

NOTE: For split lines, insert a tilde (~) in the text box where you want the line to split.
MineralLabel will automatically separate the two halves of the line. You cannot insert internal
formatting codes in split lines.

[Style]—Four check boxes control text attributes for the entire line. You can select more than one
style for any line. Clicking [Normal] removes all other style settings.

[Rev.]—This option prints the current line in white type on a black background. You cannot use
this option on split or rotated lines or when using inserted formatting commands. You can, however
use any of the other text attributes with this feature.

[Rotate]—MineralLabel lets you rotate text up to 90 degrees in either direction. Start by selected
the line to rotate, hen click this button. Use the scroll bars in the dialog box that appears to set a
rotation angle, then click [Accept] to apply the rotation. You can also click [No Change] to keep the
current rotation or [Default] to return to normal alignment.

The Clip Art Group

[AddArt]—Opens a dialog box for loading .BMP, WMF or .PCX clip art images. MineralLabel
supports black and white or color images. To see a preview of an image, click once on the filename.
To load the image, double-click the file or click OK. MineralLabel will automatically select either
the first or second clip art image, and position it in the WYSIWYG display.

NOTE: MineralLabel accepts only the file types listed above. If the graphics file you want to use is
in another format, use a graphics editor to save the file in one of the above formats.

[HideArt]—This button temporarily removes all clip art and line drawing art from the WYSIWYG
display. Since MineralLabel can overlay text on a graphic or line art object, use this command to
help you see text position better if it is obscured by a clip art image. When clip art is hidden, a
dotted box shows its location. When you click this command, its caption changes to [ShowArt].
Clicking it again will redisplay your graphics.

[Delete]—Removes the currently-selected clip art image.

[Option Buttons]—Selects one of the two clip art images. You may select by clicking the button, or
by double-clicking on the image itself. You must select an image before acting on it. Options are
PIC 1 and PIC 2. Normally, PIC 1 is on the left side of the label, and PIC 2 is on the right side of
the label. When selected, a thin border will appear around the image. NOTE: To deselect an image,
you must double-click the image.



[Scale]—Use this control to resize a selected clip art image. Remember, the command only affects
the image selected with the option buttons. For small changes, click the arrows. Click between the
arrows for larger changes. The image always stays in proportion.

HINT: Avoid major changes in clip art image size to avoid image degradation. If you need to
enlarge or reduce an image very much, do so in a graphics editing program before loading it into
MineralLabel. Also, very large images scaled to fit a label may create a temporary file when printed
that is too large for your free disk space.

Where Clip Art Files Are Stored

MineralLabel doesn’t store the actual graphical image in its .LAB files. Instead, it stores the name
and location of the file containing that image. If you move the image or delete it, MineralLabel will
not be able to find it later when you reload the .LAB file. If this occurs, the program will warn you,
and you’ll have to reload the image with the [AddArt] button.

Moving a Clip Art Image

You can move a clip art image by dragging it around the screen with the mouse. To do this, first
select the image you want to move by clicking the appropriate option button in the Clip Art Group,
or by double-clicking on the image itself. When the image is selected, a thin border appears around
the image. With the image selected, click the left mouse button somewhere outside of the image.
The image will instantly move, with its upper, left corner at the position where you clicked. Then,
with the mouse button held down, drag the image to a new location.

IMPORTANT: To avoid moving the image again by accidentally clicking on the WYSIWY G box,
double click the image once it is in its desired position.

The Line Drawing Group

[Object]—This drop-down list box allows you to select an individual object for editing. If you do
line drawings, each line, box, or circle automatically gets an object number, which appears near the
object. Select the object you want to modify in this list box.

[Width]—This box controls the width of line drawing elements. Widths range from 1 to 24 pixels
on the screen, which translates roughly to point measurements on the printer. If you change the
current setting, it will affect the current object, if present, or the next object you draw.

[Draw]—This check box enables line drawing. Click it before creating an object. MineralLabel will
automatically select the first available object number.

[Filled]—This check box appears only when you’ve drawn or selected a box or circle. If you check
it, the box or circle will be filled with the same color used to draw the box. Uncheck it to remove
the fill. NOTE: Some printers always draw a solid black box around the object. This can’t be
prevented, so test your work by printing a sample label.

TIP: MineralLabel can print text inside filled boxes. Use this technique to create boxes filled with
one color, then use a contrasting color for the text. On black and white printers, you’ll have to



experiment to get just the right effect. Also, remember that you can position text with the [Click to
Move Text] command.

[Line], [Box], [Circle]—These options determine the type of object you want to draw.

[LnColor]—This set of color bars lets you set the line and fill color for either a new object or for an
existing object picked from the object list. Select the object, then apply a color.

[Custom]—As with text, you can apply custom colors to your lines, using this command.

DRAWING AN OBJECT

To draw an object in the WY SIWYG screen, first select the type of object ([Line] [Box] [Circle]),
then set the width for the lines used to draw the object, and the color for that object. Next, click on
the [Draw] checkbox. Move the mouse pointer inside the WYSIWY G display where you want the
upper left corner of the object. While holding the left button down, drag the mouse pointer to a new
location. A rubber-band image of your object will appear as you draw. Draw slowly for best results.
When the object is approximately the right size, release the left mouse button to place your object
on the screen. A number will appear next to the object to identify it. You can move or size any
object later.

TIP: MineralLabel automatically converts all lines drawn at small angles to either horizontal or
vertical straight lines. Lines drawn at other angles will maintain their angle.

[Move], [Size] Options—These two options determine whether the scroll bars (see below) move or
size the current object.

[Scroll Bars]—Horizontal and vertical scroll bars control positioning or size of graphical elements.
Try the [Grid] command for accuracy.

MOVING AN OBJECT

Start by selecting the object in the [Object] list box. Next, click on the [Move] option button. To
move the object in, click on the [Up], [Down], [Left], or [Right] arrows on the appropriate scroll
bar. To move the object in larger increments, click the scroll bar regions between the arrows and the
position button on the scroll bar.

SCALING A LINE DRAWING OBJECT

First, select the object you want to resize, then click the [Size] option button. Then use the scroll
bars as described above to alter the size of the object.

Erasing and Restoring Line Drawing Objects

[Erase Selected]—This button erases the current image, as identified in the [Object] list box. This
erasure is permanent.

[Erase All]—This button removes all graphical elements from the screen.



MENU COMMANDS

FILE MENU

New Label Design—Clears the current label and sets up for a new design. If a label is already on
the screen, you’ll be prompted to clear it or abort.

Open Label File—Opens an existing .LAB label design file. For simplicity, store your labels in the
MineralLabel home directory. Several pre-designed labels are included.

Save Current Label—Saves the current label with the current filename. The current file will be
overwritten without warning.

Save Current Label As...—Lets you save the current design under a different filename.

Print Sheet(s) of Labels—This command prints your current labels. You’ll get a full sheet of
identical labels or a sheet of labels with different text if you’re using the MergeData commands.

Print Single Label—This command prints a single label anywhere on your sheet of labels. You’ll
be asked if you want to print on the top left label. Answer Yes to this prompt to print a test label on
plain paper to check alignment. If you answer No, you’ll be prompted to enter the row and column
where you want the label to print. WARNING: Check the manual for your printer before printing
on sheets of labels if you’ve removed previously-printed labels. Most manufacturers warn against
this practice. Proceed at your own risk.

Print Partial Sheet of Labels—This command lets you print as few as a single row of labels.
You’ll be prompted for the starting row on your label sheet and for how many rows you want to
print. WARNING: Check the manual for your printer before printing on sheets of labels if you’ve
removed previously-printed labels. Most manufacturers warn agains this practice. Proceed at your
own risk.

Multiple Copies—In most cases, you’ll be asked how many copies you want to print. If your
printer, like most laser printers, supports internal multiple copies, printing goes much faster if you
select the number of copies here. If your printer does not support this feature, which is common for
dot-matrix and inkjet printers, MineralLabel will still print multiple sheets, although the process
will take longer since the program actually executes the print command as many times as you
specify. If your labels include serial numbers, the numbering will continue to increment with each
sheet.

Print Color Sample—Every printer handles color differently. Use this command to print samples
of text in all the colors shown on the color bar chart. For most black and white printers, this will
produce shades of gray.

Printer Setup—Use this command to alter printer settings or to change printers. You’ll see the
normal Windows Printer Setup dialog box for your printer. When you return to the program, you’ll
be asked if you want to update your font list. If you changed printers, you should answer Yes to
avoid font conflicts.

Update Font List—MineralLabel handles fonts very well, but there may be times when you need
to relist your currently available fonts. This command does that. You probably will never need to
use it, since the program rebuilds its font list, if necessary, each time it starts.



Exit—Quits MineralLabel, with a confirmation box. Click [Yes] to save the current label and exit.
Click [No] to exit without saving. Click [Cancel] to return to MineralLabel.

EDIT MENU

Undo—Most commands in MineralLabel which require more than a single click, can be undone
with this Undo command. If you make a change, then decide to go back to a previous state, check
this command. If it says Can’t Undo, then change back manually. Otherwise, the command will tell
you what will be undone.

Cut—Removes selected text from the editing box, then stores it in the clipboard.
Copy—Sends a copy of selected text to the clipboard.
Paste—Copies text from the Windows clipboard to the current cursor location.

Insert Special Character—This command pops up a grid showing all the special, foreign, and
symbolic characters available in the currently selected font. Hold down the left mouse button over a
character to see an enlarged view. Double-click on a character to add it to the box at the top of the
screen. When you click the Insert command, all characters in the box will be inserted at the current
cursor location.

VIEW MENU
Zoom/UnZoom—Works just like the Zoom/UnZoom button on the left side of the screen.

LAYOUT MENU

Rotate Current Line—L.ike the [Rotate] button, this command displays the text rotation dialog
box for the current line.

Show Grid—Like the [Grid] button, this overlays a grid on your WYSIWYG display.

Mineral Labels and Cards—Displays a list of frequently needed formats for mineral collectors
and dealers. These include formats for perky boxes, shelf display cards, and lists of minerals from
your database.

Note: Normally, you’ll print these labels and cards on plain paper, then cut them with a standard
paper cutter or straightedge and knife. To help you with cutting, try an Add Border command in the
Layout menu. A border will also improve the appearance of most labels.

Standard Label Formats—Displays a list of the most commonly used Avery Laser Label types.
To select a label format, click on the Avery number or choose by size.

Other Label Formats— Displays a list of other formats, including business cards, name badges,
post cards, etc. Click on the appropriate item.

Custom Formats— MineralLabel lets you create, save, and load customized templates for non-
standard labels. If you select the Design Custom Format option, you’ll see a series of dialog boxes.
Enter the information requested, using a ruler to measure the actual dimensions on your labels.



Measurement System: Normally, you’ll enter dimensions in inches (1.5, 2.33, etc.), but you can use
any system of measurement by adding an abbreviation after the measurement. This is true any time
MineralLabel asks for measurements. The abbreviations are, mm for millimeters, cm for
centimeters, pt for points and pi for picas. Abbreviations can be in upper or lower case, but must
follow the number, with or without a space.

Saving a Template: Once you’ve created and tested a new label template, use the Save Current
Design as Template command under the Custom Formats command to save the label template.
Type just the filename...MineralLabel will add the MLT extension and store the file in its home
directory. You can save a template at any time, even if you’ve typed in text. Only the measurements
will be saved in an MLT file.

Loading a Saved Template—Once you’ve saved templates, you can load them quickly with this
command under the Custom Formats menu.

Add [Thin/Medium/Thick] Border—These commands add a simple, single line border around
your label and automatically adjusts the margins to compensate. The border may not appear
perfectly centered on the screen, due to the screen’s low resolution, but will print correctly.

Margins—Sets left or top margins separately for text. Use this command to set margins to
compensate for pre-printed areas on labels or other stock. Choose the appropriate subcommand.
Small changes have big effects, so start with small margin measurements. The default is .1 inch.
You may use any measurement system, as described above. NOTE: Margins affect only text, and
can be overridden by either the Click to Position Text or Custom Alignment options.

Fudge Factors—This command displays a submenu you can use to alter the dimensions of your
printouts slightly. Use it to compensate for slight differences between printers. In the submenu,
select the option you want to change, then enter a value in the resulting dialog box. Both positive
and negative numbers are allowed, and all measurements should be in decimal inches or in another
system as described above. Measurements are added to or subtracted from the current settings. Use
the Save Offsets as Defaults to make your changes the defaults, once you’re satisfied. This way,
you’ll only have to perform these operations once for your printer, since the default offsets are
loaded when the program runs.

NOTE: If you set incorrect fudge factors or change your printer, select the Delete Saved Offsets
command under the Fudge Factors menu to return to default settings.

Left Align All Lines—Sets all lines on a label to the left margin. You can override this setting or
any of the other All Lines settings, by using the Align list box on any line.

Center All Lines—Centers all lines on the label. NOTE: Some special formatting, such as
superscript and subscript will disable this centering, since lines containing this formatting cannot be
accurately centered.

Right Align All Lines—Sets alignment for all lines to the right margin.

Insert Formatting Codes—The commands in this submenu insert special codes in your text which
allow you to alter the appearance of just part of a line or to create special formatting as in a
chemical formula. Whenever possible, use the whole line formatting tools instead.

Normal—Inserts <Norm> in the line. This code returns the line to normal text.



Bold—Inserts <Bold> in the line, boldfacing the following text.
Ital—Inserts <Ital> in the line, italicizing the following text.
Underline—Inserts <Undr> in the line, underlining the following text.
Superscript—Inserts <Supr> in the line, superscripting the following text.
Subscript—Inserts <Subs> in the line, subscripting the following text.

NOTE: You cannot use inserted codes in Rotated Text or in lines which have their alignment set to
Centered, Right-Aligned, or Split at Tilde. This would cause misalignments.

Insert Serial Number—Inserts a <Ser#> code for a serial number at the current cursor location.
When you give this command, you’ll be asked for the starting serial number. Enter only a number
in this dialog box. After entering a starting number, you’ll be asked if you want to enter a
“formatting string.” Leave this blank if you just want to print the number as-is. This can let you
format your serial number in just about any way you wish. Here are some examples of formatting
strings, with the results as they will print, if you entered the starting number as 1:

Formatting String Result Note

No formatting string 1

000-000-000 000-000-001 Use for Leading Zeros

T 1 Prints only numbers that exist

101-000-000 101-000-001 Numbers in string print as-is

\A\B0000-000-000 AB0000-000-001 Precede each character with a
backslash

NOTE: Serial numbers are stored when you save a label. If you print serial numbered labels, be
sure to save them before exiting MineralLabel to preserve the sequence next time you load the label
file.

CLIP ART MENU
Insert Clip Art File—Lets you choose clip art files, just as with the [AddArt] button.

Position Current Image—With either the PIC1 or PIC2 option buttons selected, this command
will allow you to specify a precise position for the upper left corner of either clip art image. When
prompted, enter dimensions in any measurement system, as described elsewhere in this manual.

Edit Current Picture—Starts Windows PaintBrush and loads the picture selected with the option
buttons for editing. When you exit PaintBrush, you’ll return to MineralLabel. To use the altered
image, delete the current image, then use [AddArt] to reload the image from disk. NOTE: you
cannot edit WMF files in PaintBrush.

OPTIONS MENU

Make Current Font Name Default—This command sets the current font, as highlighted in the
font menu, as the default for all blank lines in your label. Use this command before entering any
text.




Make Current Font Size Default—As above, but sets the current font size as the default for blank
lines in your label.

AutoFit Enabled—Turns the AutoFit function for Merged labels on or off, as described below in
the Using MergeData section of this manual. This feature is on by default, and automatically
shrinks a line’s font size until the text fits on the label.

Automatic PostNet Barcode—Turns POSTNET bar code display and printing on or off. When this
command is checked, MineralLabel finds any ZIP code on the last line of your label and
automatically creates a centered POSTNET bar code at the bottom of your label. This function
works both in manual labels and merged labels from the Database.

NOTE: For this function to work, the ZIP code must be the last item on the bottom line of the label.
Otherwise, MineralLabel won’t find the code.

Enable Merge Coaches—MiineralLabel will normally help you during merges using the database
by displaying prompts during the process. If you do not wish to see these after you’ve learned the
program, click this command to add a checkmark, then save the settings using the command below.

Save Default Settings—Stores the Font, Size, POSTNET, AutoFit, and Merge Coach settings
made earlier in a file which is loaded each time MineralLabel runs. Use this command if you want
to save these settings for use in most labels.

Delete Default Settings—Deletes the default settings file. Use this command if you want to make a
permanent change in your default Font, Size, Coaches, and AutoFit settings.

MERGEDATA MENU

Giving this command opens the MineralLabel Database, where you can create, import, find, store,
and edit data such as mineral specimen information or addresses for use with the program. See the
Using MergeData section of this manual below for details.

HELP MENU

Help with MineralLabel <F1>—This command opens a new window. On the left is an index of
topics. To get help on a topic, just click on the topic’s name. You can scroll through the list or type
the first letter of your topic.

About—Displays information about MineralLabel, including the current version number and
support information.

OsoSoft Program Information— Ignore this information. OsoSoft is no longer in the software
business. We do not accept orders for any software.

USING MERGEDATA

The MergeData menu command opens a new window in MineralLabel, containing a simple
database you can use to store and select mineral specimen information or addresses for automated
use on your labels and for printing pages of different labels. When you first open the Database, with
the MergeData*Database command, you’ll see an empty list box.



Creating MergeData Files

You can store up to 750 entries in each MergeData file, but you may have as many files as you like.
The default file extension for databases is .ADR, and you should stick to that extension.

To create your first MergeData file, select the [Edit] or [Add] button, then type in the information
you want to enter in the 5 boxes that appear. You can type anything you like in each field, but each
line is limited to 60 characters. Enter the data as you want it to appear on the labels. For best results,
fill out the lines in order, avoiding blank lines between two full lines. Click the [Add] button to
create additional entries. When you’ve finished entering data, select the [Save] button, then enter a
file name. HINT: Enter the filename without an extension. The Database will add the .ADR
extension automatically.

NOTE: If you include ZIP codes in your data, be sure to put them at the end of the last field in the
record.

Working With The List View

When you give the Database command, the Database list is empty. Use the [Open] button to bring
up the file selection dialog. After selecting an ADR file, you’ll see the List View, with the first field
in each record appearing in the list box. The list is always unsorted.

To edit a record, click on the record, then click the [Edit Record] button to move to the editing
display for the currently selected record. If you have selected multiple records, the record
surrounded by the dotted box will appear in the editing fields.

To add a record, click the [Add Record] button. The Database will find the first blank record in the
file and move to the record editing field. If records have been deleted, leaving blank spaces in the
list box, you’ll be adding the first blank record.

To delete a record, click the [Delete Record] button. After you confirm your decision, that record
will be removed. If multiple records are selected, the record surrounded by the dotted box will be
deleted.

To search for text anywhere in a record and display that record, select the [Find] button. Enter the
text to find in the dialog box and click [OK]. To find the next occurrence of a search, select [Find
Next].

Using The List View To Select Records For Printing

IMPORTANT: Before you can use any of the records in a label, you must first select the
records you want to print.

To select a single record, just click on the line for that record. Most often, you’ll want to select
multiple records for use on your labels. You can hold down the left button and drag the mouse over
multiple records, or hold down the <Ctrl> key and click on individual records to select non-adjacent
records.

For faster selection of multiple records which contain the same text, you can also select records
using the [Find & Mark] and [Mark All Except] buttons. For example, to automatically select all
records which contain the word “Waulfenite,” click [Find & Mark], then type Wulfenite in the dialog



box and click OK. To select all records except those containing a particular word, click [Mark All
Except], then type the word you don’t want selected and click OK. If you want to select all records,
click [Mark All Except], but leave the search area blank. Use the same technique for locating and
marking records for mailing lists, etc.

FIND & MARK HINTS:

Click the [Match Case] check box to turn case matching on and off before starting your Find and
Mark operations. If the box is checked, searching for ca willl find calcite and cadmium, but not CA
or California. If the box is unchecked, the search will find all of these.

Use the [Mark All Except] button to find every record except ones containing particular text.
To clear all marked records, just click on any record in the list. Don’t do this accidentally!

Using the Edit View

When you give the [Add Record] or [Edit Record] command, you move to the edit view, with the
five fields for a label displayed. Press <Tab> or <Enter> to move to the next field, and <Shift>-
<Tab> to move backward. Normal Windows text editing procedures apply to the fields. If you need
to insert special characters, use the Special Characters command to display the Insert Characters
dialog box. It is used as described earlier in this manual.

New buttons appear in this view, under the field display. Select [Return to List View] to return to
the list view after editing or to select records for printing. Select [Next] or [Previous] to scroll
through the records, one at a time. The current record number always appears at the top right of the
window. The [Dupe This Record] button adds another copy of the record on the screen, starting
with the next available blank record. Use this to create as many duplicate entries as you like, then
edit only the information that is different. .

While in this view, you can use the [Add Record] or [Delete Record] buttons as well. All other
buttons also work in this view, including the [Find] button. If you’re working in this mode and want
to mark a record for printing, click the [Mark] button. You can repeat this command as often as you
wish. When you return to the List View, the record you marked will appear highlighted, and ready
for merge printing.

Creating Formulas

MineralLabel can create chemical formulas in its database entries, using the [Normal], [Bullet],
[Superscript], and [Subscript] buttons to insert formatting codes in your text. For example, to enter
the formula for Glauberite Na2Ca(S0O4)2 you would type Na, click the [Subscript] button, then type
2. Next, click the [Normal] button and type Ca(SO. Click the [Subscript] button and type 4, then
click the [Normal] button and type ). Click the [Subscript] button and type 2 to finish the formula.
Remember: Any code you insert remains in effect until you insert another code.

IMPORTANT: You must remember to insert the [Normal] code to resume normal formatting after
using any other code.

Later, when you merge your data into your lables, MineralLabel will substitute the correct
formatting for your codes and print the formulas correctly.



NOTE: Lines containing these formatting codes will always appear aligned with the left margin of
your card or label.

Importing Data from Other Programs

MineralLabel’s database can import data from any program that can export a database in standard
comma-delimited format. See the other program’s manual for instructions on exporting a database.

To import a database file, click the [Import] button in the Address Book Menu. For complete, step
by step instructions on importing a file, click the [Instructions] button in the Import Dialog Box.
Follow these steps closely for best results.

NOTE: Since data stored in other programs is usually stored in smaller, individualized fields than
used in a labeling program, MineralLabel’s import facility lets you merge individual fields on on
line of its own data files. You’ll find details on the [Instructions] screen.

TIP: If you want your records from an imported file sorted in a particular way, such as by zip code
for a mailing, sort the records before exporting the data to a comma-delimited format.

NOTE: In a few cases, with comma-delimited files created by some database software, data will
not be saved properly in the Import screen. If this occurs, you can still use the data, but
MineralLabel may not be able to detect how many records you have selected for printing. If this
occurs, simply re-save the .ADR file in the main database module then open the file again. That will
correct the problem permanently. NOTE: It’s always a good idea to resave and reopen files you’ve
imported, after returning to the Database screen.

Exporting Data from MineralLabel’s Database

You may wish to use data stored in MineralLabel in other applications. While in the MergeData
Database module, click the [Export] button to do this. MineralLabel will automatically export your
data into a comma-delimited file format, which can be imported into

any other database program. The filename used for the export will be the same as the filename for
your ADR file, but with a CSV extension instead. See the other program’s documentation for
instructions on importing comma-delimited files.

Preparing to Use Data In Labels

IMPORTANT: Before you can print labels or cards using data from the database module, you
must select the records you want to print. See the earlier section in the manual on selecting records.

When all records you want to use are selected, click the [Return to Label] button to return to the
main MineralLabel window.

You’ll see a dialog box asking if you want to save your data if you’ve made any changes. Next,
you’ll be asked if you want to use the data in your labels. Answer [Yes] to use the data, [No] to
return to the main window without using the data, or [Cancel] to return to the Database.



Using Database Data in Labels

IMPORTANT: Before you can print labels from data stored in the database, you must insert
markers on your label to represent the lines or fields in the database. Follow the steps below to do
this.

Once you return to the main MineralLabel screen after selecting records in the database module,
you can use the data you’ve selected on your labels. It’s best to start with a blank label. If you
already have a label on the screen, use the [New] or [Clear] commands to clear the label. Then
you’re ready to create a label template, using the MergeData*Insert Field command

MergeData*Insert Field—When you click this menu item, you’ll see a sub-menu used to insert
field codes in the text editing box. Click any of these entries, or press the associated function key to
insert the appropriate code, which will look like: {Linel}, {Line2}, and so on.

CAUTION: Don’t put any other text on a line containing a field code; It will be ignored when you
print. However, you can put whatever text you wish on other lines. This text will print on all labels,
and is useful for information such as your name or company name.

These codes represent the fields in your database. You can align the codes any way you like, apply
formatting like boldfacing, italics, etc., and choose fonts and font sizes for each line. You can also
use the automatic formatting options in the Layout menu to center lines or make them all left or
right aligned.

HINT: Notice the function key shortcuts (F2-F6) in this menu. They can save you time by letting
you simply press the key to insert field markers.

HINT: You can place more than one field marker on a line. If you do this, you’ll see additional
prompts when you print,which ask if you want commas to separate the fields. If you choose not to
have commas inserted, a space will be inserted between fields automatically.

While you can’t put other text on the lines containing the fields, you can include any other text you
wish on other lines. This lets you customize your labels. You can also include clip art images on
labels which use database data.

POSTNET Bar Codes—If you’ve checked the Automatic PostNet Barcodes command in the
Options menu, you’ll see a dummy bar code on the screen as you insert field markers. Use this to
help you set font sizes for your lines to avoid conflicts with text and the bar code. HINT: 8-point
Avrial type works quite well for 4 or 5 line labels on the default 5160 label stock.

Printing MergeData Labels

Once you are satisfied with your label, just use the normal Print Sheet(s) of Labels command to
print all the labels you selected. If you’ve selected fewer addresses than will fit on a label sheet, the
remaining labels will be blank. If you’ve selected more addresses than will fit on one sheet,
additional sheets will print. You’ll be told how many sheets you’ll need before beginning to print.

AutoFit

MineralLabel can automatically shrink the size of database text which would not normally fit on
your label. This valuable tool lets you ignore the length of text when laying out your labels. To turn



this feature off, select the AutoFit command in the Options menu. The check will be removed, and
your label text will no longer automatically shrink if it’s too long. This option is normally on, and
should normally be left on exept in special circumstances.

NOTE: AutoFit is very valuable, but vertical alignment is also affected when MineralLabel shrinks
text. It’s best to try to choose font sizes that work correctly with most entries in your database file.

Transferring A Single Record for Printing

At times, you may want to print a sheet of labels or a partial sheet, using one record from the
database. To do this, select the record in the MergeData Database module, then give the
Record*Transfer Record to Label command. This will move the record to the main module, with
one record per line on the label. You can then format the label in any way you wish and print as you
normally would.

Database Tips

Be extremely careful about printing partial sheets of labels, especially in laser printers. If you peel
off a label inside the printer, you may face expensive repairs. In some cases, you can reverse a
partial sheet of labels, but it’s not recommended! If you use the Print Partial Sheet of Labels
command, it’s best to leave the labels you printed earlier attached to the sheet.

Don’t leave blank lines between full lines when entering data in the database. MineralLabel doesn’t
remove blank lines when printing. It’s better to enter each label with consecutive fields full.

If you need to start a new database when a current ADR file is loaded, select File*New to make sure
you maintain correct record numbering.

EDITING YOUR DESIGNS

Controlling Line Spacing

To make fine changes in the spacing between lines of text, make sure there’s at least one blank line
between the lines you want to change. Then, position the cursor on a blank line and change the font
size for that line. When you update the display, you’ll see the changes on your screen. You can
make changes in 1-point (1/72”) intervals. If you need a font size smaller or large than those offered
in the font size list, simply type it in the display area of the list. MineralLabel does not accept
fractional font sizes.

Placing Text Beside Clip Art

You’ll often want to position text next to or around clip art images. To do this, use the [Alignment]
options or the Click to Position Text check box.. For example, to position text to the right of an
image, choose the Right Aligned alignment option, then add spaces after the text to move it to the
position you want. Similarly, use the Left Aligned option to position text to the left of an image.
This time, however, place your spaces to the left of the text. To wrap text on both sides of an image,
insert a tilde (~) where you want the text to break, then choose the Split at Tilde alignment option.



Once again, pad the text with spaces to achieve the position you need. Don’t forget the Custom
Alignment or Click to Move Text options for even more flexible positioning of lines.

Overlaying Graphics with Text

You can print text on top of clip art graphics, but this text may be partially obscured on the screen
by the graphic. To see text which will overlay a clip art image clearly, click the [HideArt] button. A
dotted box will appear to show where the graphic is located. Use overlaid text with caution, since it
may obscure part of a clip art image. HINT: Try using a contrasting color for text which overlays a
graphic.

Working with Split Lines

MineralLabel’s ability to split lines is very powerful, letting you position blocks of text on both
sides of the label. Normally, the left half of the line is flush with the left margin, while the right half
is right-aligned. Often, however, you’ll want to center blocks of text or manipulate the alignment in
other ways. As described above, use spaces to pad the text until it’s aligned just the way you want.
NOTE: You cannot use this feature with merge fields.

Creating Columns in MineralLabel

It’s easy to create columns for text. To do this, select a custom alignment or use the Click to Move
Text command for the first line in the column, positioning it exactly where you want it to appear on
your label. Then, either enter new text on subsequent lines or click the [Dupe Prev] button on
subsequent lines. All lines will line up with the first line.

TIP: When creating columns of text, it’s best to place this text at the bottom of the text in the text
window. This helps prevent misalignments of other text.

Working With Rotated Text

If you want to use rotated text on a label, it’s best to add the text to the bottom of the text box. This
helps prevent misalignments of other text on the label. Before typing the text to be rotated, click the
Click to Move Text check box, then click and drag in the WYSIWYG window to position the top
left of the text to appear. Then type the text and click [Update]. You can use Click to Move Text as
often as you like to get just the right positioning.

Printing Samples

When working with complex label designs, it’s a good idea to print occasional samples of your
design for checking, and to save your work frequently. After printing a sample, you can make
changes to correct slight misalignments. For speed, use the Print Single Test Label command.
REMEMBER: This sample label prints in the top left location on the label stock you’re using. Use
this command to check alignment if you’re using Fudge Factors.



MineralLabel TIPS

Printing
e Printing takes time. MineralLabel and Windows have to compose graphical pages before a
page emerges. You’ll need a little patience.

e If you’re printing shelf display labels, use a lightweight card stock for best results. You can
buy this paper at any copy shop. Make sure the paper will feed correctly in your printer. Buy
just a few sheets and try it out. If it jams, buy a lighter weight paper.

e For maximum quality when printing MineralLabel label designs, be sure your laser printer
has a good toner cartridge.

e MineralLabel can handle color clip art images, but the final output will depend on how your
printer interprets the colors in your clip art. HINT: If some colors print as black on a color
printer, change that printer’s settings in the Printer Setup dialog box.

Notes for Inkjet Printer Users

e Some DeskJet printer drivers set their ZERO point differently than most printers. You may
have to set Fudge Factors to get proper alignment with standard label sheets. Print a sample
sheet of labels with text in the upper left corner, then set Fudge Factors to compensate for
misalignment. When your labels are properly aligned save your Fudge Factors as the
defaults and you’ll be able to ignore these items from then on.

e Watch your bottom margins. On some label formats, text too close to the bottom of a label
may cause the printer to eject pages rather than printing the last row of labels.

e Try setting the paper size to Legal if your printer ejects pages and doesn’t print the bottom
row of labels.

e DeskJet color printers may print some of the colors as black if Dithering is set to Standard.
To fix this, set the printer for any other Dithering type in the Options section of the Printer
Setup dialog box.

REMEMBER: Load label sheets face down in your DeskJet’s paper tray!

Working With Clip Art Images

MineralLabel accepts .BMP, WMF, and .PCX graphics files. Graphics programs, such as Windows
Paintbrush, supplied with Windows 3.x, can create these files. You can convert other file types,
using any of a number of format conversion programs.

The size of your image is important. Art for labels is quite small, almost never exceeding 1” in any
dimension. While MineralLabel can handle much larger images, it’s usually better to scale large
images in a program specifically designed to do that. Windows Paintbrush can handle preliminary
scaling quite well. If you have a scanner, you can create your own clip art in minutes. Simply scan
the image, then use your scanner software to produce a .BMP or .PCX file approximately 300



pixels in each dimension. Naturally, tall narrow images will use other dimensions, but you get the
idea.

You can also create clip art images with any paint program that can produce .BMP or .PCX files.
Creating custom logos isn’t difficult at all. Also, a number of clip art libraries are available, both
commercially and as shareware. Often, however, these images may need conversion to a supported
format or scaling. You’ll also find interesting clip art files on the OsoSoft BBS.

Clip Art Tips
e Very thin lines often don’t print well.

e Large black areas sometimes don’t reproduce as completely black.
e Reducing a large image to label logo size often results in loss of detail.

e Increasing the size of tiny images usually results in jagged lines on your printout.

Lines, Boxes, and Circles

e You cannot draw a graphical element that extends into a clip art image. The line will end at
the edge of the image. You can, however, overwrite text with a line graphic. Let the
WYSIWYG display be your guide. Be careful not to let lines, boxes, or circles extend past
the label’s borders. Always check the WYSIWY G display for conflicts, and print a single
test label as a final check.

e Use the [Update] button to see the results of your changes. As you draw and move lines, text
may not appear if it has been overwritten. Update to see the actual image.

e You can also draw boxes or circles, with fills, around existing text on your design. It’s best
to first create the text, then follow up with lines, boxes, and circles. Use the positioning
scroll bars for precise sizing and placement, and print a quick sample to make sure no errors
occur due to the different resolutions of your screen and printer.

e Tryusing a filled box or circle to set off text. Use a light color with black or dark colored
text or a dark color combined with white text for special effects.

e Overlaying white text on a black filled box is the best way to create reversed text. The
Reverse command included with the program is primarily there for compatibility with
previous versions, but is not as good a way to create reversed text as a filled box.

Business Cards

You can use MineralLabel to create instant business cards on stock available from Avery, Paper
Direct or other suppliers. It’s a quick way to produce these valuable cards in small quantities you
can use.

Name Badges

MineralLabel supports all the name badge products from Avery and other suppliers. If you need
name badges for a mineral collectors club or a show, use the database to create lists from any



source, then print all the name badges in one pass. It can save hours of typing and produce a
professional look.

Post Cards

Post cards are a valuable form of advertising, and MineralLabel can create them quickly and easily,
in either vertical or horizontal format. Print your cards either on pre-scored label stock available
from many suppliers or on plain label stock (67 Ib. max for laser printers), then cut them on a paper
cutter.

HINT: Print post cards in two passes...one for your message, then another pass on the other side,
using the database to do an automatic mail merge for your customer list. You can easily print on
both sides of the paper.

TROUBLESHOOTING

e Setup Doesn’t Work—You may have older versions of some of the files needed by
MineralLabel installed in incorrect directories. Load README.WRI into Windows Write
and use the manual installation procedures described there.

e Small Fonts Appear Incorrectly in the WYSIWYG Display—Due to the way Windows
handles TrueType fonts smaller than 8.75 points, your WY SIWYG display may not display
these fonts correctly in small sizes. They will print correctly, however.

e Reversed Printing and Shaded Text Don’t Print Correctly—Change your printer settings
with the Printer Setup command to enable the Print True Type Fonts as Graphics check box.

e Labels Print in The Wrong Place on The Sheet—Use the Fudge Factors command in the
Layout menu to adjust MineralLabel for your printer.

e All But the Last Row of Labels Prints, Then My Printer Ejects a Page—See the section of
this manual on inkjet printers, and try setting the printer for Legal Sized paper.

e My Labels Don’t Line Up On The Label Stock When I Print—Use the Fudge Factors in the
Layout menu to adjust the program to suit your printer. When you get it exactly right, save
these factors as default settings. Use the Print Single Test Label command in the File Menu
to help check alignment.

Files Included for Mineral Collectors and Dealers

MineralLabel includes several pre-formatted LAB files specifically designed for mineral collectors
and dealers. These files already have the database fields inserted, making it easy for you to create
labels and cards for your specimens. Here’s a list of those files, and how you might use them.

112X112P.LAB—Predesigned label for small perky box insert cards, with database field markers
inserted. Print these on light card stock, then cut them on a paper cutter for quick thumbnail labels.



175X125P.LAB—Predesigned label for 2”x1.25” perky box insert cards, with database field
markers inserted. Print these on light card stock, then cut them on a paper cutter for quick
thumbnail labels.

225X2P.LAB—Predesigned label for 2.5”x2.25” perky box insert cards, with database field
markers inserted. Print these on light card stock, then cut them on a paper cutter for quick
thumbnail labels.

25X125P.L AB—Predesigned label for 2.75”x1.25” perky box insert cards, with database field
markers inserted. Print these on light card stock, then cut them on a paper cutter for quick
thumbnail labels.

LCARDTOP.LAB—Predesigned label for use as a cabinet display card. Field Markers are pre-
inserted at the top of the card, so the text shows above the specimen. 2”” x 3” cards, 12 per sheet.
Print these on light card stock, then cut them on a paper cutter.

LCARDBOT.LAB—~Predesigned label for use as a cabinet display card. Field Markers are pre-
inserted at the bottom of the card, so the text shows in front of a specimen placed on the card. 2” x
3” cards, 12 per sheet. Print these on light card stock, then cut them on a paper cutter.

SCARDTOP.LAB—Predesigned label for use as a cabinet display card for thumbnail and miniature
specimens. Field Markers are pre-inserted at the top of the card, so the text shows above the
specimen. 1.5” x 2” cards, 15 per sheet. Print these on light card stock, then cut them on a paper
cutter.

SCARDBOT.LAB—Predesigned label for use as a cabinet display card for thumbnail and
miniature specimens. Field Markers are pre-inserted at the bottom of the card, so the text shows in
front of a specimen placed on the card. 1.5” x 2” cards, 15 per sheet. Print these on light card stock,
then cut them on a paper cutter.

MINLIST.LAB—Predesigned label for use as a list of minerals in your database. Prints in three
columns, thirty entries per page. Print these on plain paper to create an attractive list for your
collection.

PRICELST.LAB—Predesigned label for use as a price list by mineral dealers or traders. This label
has fields inserted all on one line and prints 50 entries per page. Use this label with a database file
which has your information, including the price in the last field. Since MineralLabel has the
AutoFit feature, all your information will print on each line, no matter how much text you’ve
entered in the database fields. This list is also great for printing out lists of your collection, if you
store your collection data in MineralLabel’s database..

Designing Mineral Databases

The data you put in your database for your minerals should be considered carefully, since you’ll use
it to print many types of labels and cards.

For collectors, 1 suggest the following order in the records in your database file:
Line 1:Name of Mineral & Catalog Number
Line 2: First Line of Locality



Line 3: Second Line of Locality
Line 4: Third Line of Locality

Line 5: Miscellaneous information,such as price paid, source where you obtained the specimen,
drawer number, chemical class, etc. Remember, you only have 60 characters

For dealers, I suggest the following order:
Line 1:Catalog Number and Name of Mineral
Line 2: Chemical Formula

Line 3: First Line of Locality

Line 4: Second Line of Locality or Description
Line 5: Brief Description and Price.

Dealers may also want to maintain their customer list in MineralLabel’s database to simplify
creating labels for shipping. Also, use MineralLabel to create business cards, shipping labels and
other items needed by your mineral business.



